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5. Refining the Presentation 

Once you have prepared the slides you want in your presentation, it is time to give it the final touch". You 
may already think that it looks very good, but PowerPoint offers many more things you can do to make 
your presentation is perfect. 

Before you begin refining, it is a good idea to review your presentation as a slide show. It will help you 
decide whether the order of your slides needs to be changed, whether to insert some transition effects, or if 
anything needs adapted on the individual slides, such as location and size of pictures and charts. 

You should adjust the individual slides before you proceed. 

5.1 Date, Time and Slide Number 

You can insert the date, time and slide numbers in your presentation. They appear discreetly in the bottom 
of each slide. It looks nice, and also gives an impression that the presentation is made for the specific 
occasion. 

If you print handouts, the information will also be displayed here. 

1. Click on the Insert Tab in the Ribbon. 
2. Click on the Header And Footer button. 

Figure 58: The Header And Footer button.

This open the ”Header and Footer” window.  

http://bookboon.com/


Download free eBooks at bookboon.com

Microsoft Office PowerPoint

61 

Refining the Presentation

Figure 59: The “Header and Footer” window.

You may have noticed that there are also some buttons in the Ribbon called Date And Time, and Slide 
Number. These two buttons do exactly the same as the Header And Footer button. 

We will insert the current date, which is updated automatically. We will also insert slide numbers and a 
text that says that it is a practice presentation. 

3. Set the settings as shown in Figure 21 and click the Apply To All button. 

Figure 60: Slide with Footer.
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A discreet footer has now been inserted on all your slides. Had you pressed the Apply button instead of 
Apply To All, the footer would only have been inserted in the current slide. 

5.2 Order of the Slides 

This is what to do if you decide that the order of your slides should be different. 

In standard view you can change the order by moving the thumbnails on the left side of the screen, but if 
you have many slides in the presentation the "Slide Sorter" view is easier to work with. 

1. Select the View Tab in the Ribbon. 
2. Click the Slide Sorter button. 

Figure 61: ”Slide Sorter” view.

You now have a complete overview of your slides in the form of thumbnails. To change the order you 
must do the following: 

3. Click on a slide with the left mouse button. To select several slides, hold down CTRL key on the 
keyboard while clicking on the other slides to be selected. 

4. Click on any of the selected slide with the left mouse button and hold the button down. 
5. Using the mouse, move the selected slides to the place where you want them. You will see a 

vertical line between the slides where the selected slides will be inserted. 
6. Release the mouse button. 

That is basically all there is to it. 
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5.3 Transition Effects 

When your presentation is shown, it is simply slide by slide. You have not made any transition effects yet, 
so switching between each slide occurs without any effects. 

There is of course nothing wrong with that, but why not add a nice effect when you switch from one slide 
to another? It is free! 

PowerPoint has a variety of transition effects you can use to make the transition between each slide more 
elegant. However, I advise you to not use too many transition effects during a presentation. Firstly, it 
distracts from your message, and secondly, it can seem a bit "amateurish". 

Instead, choose a simple effect that you use throughout your presentation. It ”lifts’ the presentation and 
makes it appear neat and complete. 

1. Ensure that you in the “Slide Sorter” view. You can work with transition effects in the other views, 
but since you must use only one transition effect in this presentation it is easier to work with this 
view. 

2. Click on one of your slides. 
3. Select the Animations Tab in the Ribbon. 
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In the Animations Tab you can choose transition effects (see Figure 24). There are more effects than are 
immediately visible. You will find the rest by clicking on the arrows to the right of the buttons. 

Figure 62: Here you can choose the transitions to the slide. 

In addition to the animation buttons, you can also adjust the speed of the transition, add sound effects, and 
choose whether the transition should be manual or automatic following a predetermined time interval. 

Be careful with the sound effects, especially if you are doing a lecture. It distracts from what you are 
saying. 

In this exercise the transition is made, by clicking with the mouse. If you are doing a lecture, I strongly 
recommend this. If there is a question from the audience that takes a bit of time to answer, you will have a 
hard time catching up with your slide show. 

In contrast, the timed delivery is needed if your presentation is to be used on an information screen that 
runs in an infinite loop. 

4. Select a transition effect and adjust the speed. 
5. Click the Apply To All button. 

You now have a nice transition between all your slides. Review the slide show by pressing the F5 key on 
your keyboard. Change by clicking the mouse. 

5.4 Animations 

Beyond transition effects you can also add animations inside each slide. You can, for example, have the 
text in the bulleted list revealed little by little, or you can make an image fly in from the right. 

As with transition effects, you must also be a little cautious and moderate with your animations. It can 
easily appear excessive and interfere with the message you want to convey. But well-chosen animations in 
the right places help reinforce your message and in many cases make it easier to understand.  

We will do two animation exercises; one text animation and one picture animation. 

5.4.1 Text Animation 

We will animate the text first. The bullets in the second slide in the practice presentation are suitable for 
this exercise. We will make an animation that makes every line of the bullet list appear one by one. 
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1. Go to slide number 2 in the practice presentation (Figure 21). 

The slide is a bulleted list with 5 lines of text. We want the text to be revealed little by little when we play 
the slide show. 

2. If you are not already in the normal slide view, switch to it now. To do this, select the View Tab 
in the Ribbon, then click the Normal button, far left. 

3. Click the text inside the bulleted list, to make a frame appear around it. 
4. Click on the Animation Tab in the Ribbon. 
5. Click on the drop-down list Animate in the Ribbon (see Figure 63). 

Figure 63: The Bulleted list has been marked and the Animate button has been clicked.

When you click on the Animate button, a small menu appears where you can choose between different 
types of animations. 

6. Initially you just point to the individual types of animation, and PowerPoint will show you an 
example of how it will look. 

7. In "Fade Out", click By 1st Level Paragraphs.
8. Test the animation by clicking the Slide show button, which is one of the view buttons at the 

bottom right of the screen. Clicking this button starts the slide show from the current slide. 
9. Click with the left mouse button when you want to advance the animation. 
10. when you are finished, press the ESC key on the keyboard. 
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Figure 64: Here you choose speed and animation.

This is the simplest way to animate text. But there are many more possibilities we also must look at. 

11. Make sure to you are in normal view, and make sure that the bullet list is selected. 
12. Click the Custom Animation button in the Ribbon in the Animation Tab. 

This opens a panel on the right side of the screen where you can manage all the different animations that 
you can paste into your slide.  
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Figure 65: Viewing the "custom animation" panel.

The panel's top part contains settings for each animation. During the panel you can see a list of all the 
animations that are embedded within the slide. Right now we only have a single animation – or it looks 
that way. 

We have in fact five animations, one after the other. PowerPoint has just chosen to group them since they 
are naturally linked. To see the complete list, click on the small double arrow during animation list. Then 
you will see that there are five animations. Click the double arrow again to "collapse" the list again. When 
the list is collapsed, we can work with all five animations at once and ensure they are animated in the 
same way. This makes them work as one single animation. 
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Figure 66: There are five animations when you roll down the list.

In the slide, you can also see that there are five animations since there are some squares with numbers in 
them next to each line of text. These are the numbers of the animations. 

Figure 67: Animation numbers.

In the right panel you can do some different things. You can click on an animation, which enables you to 
change settings for how it starts and how fast it should be played. 

You can either choose that the animation is started by a mouse click, or when the previous animation starts, 
or after the previous animation is completed. 

The speed can be selected on a five-step scale from "very slow" to "very fast".  

You can also change the order of the animations. You do this by clicking with the left mouse button on an 
animation in the list, holding the mouse button down and dragging the animation up or down in the list. 

If you double-click on an animation, there are additional options you can set. You get access to all the 
options that are available for the selected animation, which in this case is "Fade Out". 
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Figure 68: Window with all settings. Note the Tabs. 

You can insert animations defining how the text should appear, but also what happens to it after it has 
appeared, and how it might disappear again. It is done via the Add Effect button at the top of the panel. If 
you cannot see it, or if it is called Replace instead, it is because you have selected an animation in the list. 
If so, click on any text in the slide and the button will change to Add Effect.
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Figure 69: The button Change.

The Replace button has the same content, but it will replace the animation you have selected in the list 
with the new one, you choose.  

Now you have a good idea of how to animate text, but you will not get really good before have 
experimented with it yourself , so I encourage you to play around with the various options. 

5.4.2 Animating Images and other Objects 

Everything can be animated in PowerPoint. In addition to being able to choose between various text 
animations, you can also animate images so that they fly in from the right or grow out of the background. 
You can also make them fly around a track on the screen, which you have drawn yourself. 

The possibilities are endless, and there is ample opportunity to play around with it.  

You can use the same animation tools that you used to animate text, but we must also look at a few more 
tools.  

We are starting once more with the practice presentation. Let us look at slide number 3, where we inserted 
a picture and some text. At present this slide has no animations, but we will change that now. 

1. Click on the picture to select it. 
2. Choose the Animation Tab in the Ribbon, if it has not already been chosen. 
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Figure 70: This picture needs to be animated. On the list in the  
panel to the right we can see that there are no animations yet.

3. Click on the Custom Animation button, if ot is not already enabled 
4. Click the Add Effect button in the panel on the right side. 

Figure 71: The Menu path is long, before you can change movement of the picture. 

5. Point to the Motion Paths menu item until a submenu opens.  
6. Point to the menu item Draw Motion Path until another submenu opens. 
7. Click the Free Hand menu item. 
8. Click with the left mouse button somewhere on the slide and hold the button down while drawing 

some "doodles" on the slide. Finish by releasing the mouse button. I recommend that you finish in 
the middle of the image to be animated, as it gives the nicest finish to the animation. 
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PowerPoint then shows an example of what the animation will look like. 

You can edit the curve you have drawn by right-clicking it, which will open a menu with various options. 

Figure 72: An exaggerated example.

Personally, I think it is fun to make animations in this way. It is fairly easy, and you can create some quite 
stunning effects, so I encourage you to experiment with it. 

Animations can be used for more than just flashy effects. I once illustrated flow of production in a factory 
using PowerPoint. The slide consisted of a floor plan of the factory on which arrows would appear in a 
sequence that showed which way the products are moved through the factory. 

5.5 Setting the Slide Show 

Let us say that your presentation is complete. You have all the slides you want, arranged in the correct 
order, and you also have the animations you need. 

Before you are done you should look at the settings for the slide show. There are different things to choose 
between, and some of them depend on what your presentation is for. It makes a difference whether you 
want use the show for a lecture, or for a display in a shop window. 

1. Choose the Slide show Tab in the Ribbon. 
2. Click on the Configure Slide show button. 
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Figure 73: The Button Set Up Slide Show.
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Now the window "Configure Slide show" comes up. Here you can set the basic functions of the show. 

Figure 74: The window Configure Slide show .

Only some of the settings are important to know.  

 You are probably always going to set "Slide Type" to Presented By A Speaker, no matter what the 
purpose of your presentation is. 

 Under "Show Options" menu, select whether the slide show should run in a loop until you press 
ESC on your keyboard. You must select that option if your slide show is for a shop window or 
similar, where it must run automatically.  

 You can also choose pen colour. This is because you can draw arrows and lines with the mouse on 
your slides during the presentation. The pen colour should have a good contrast with the colour 
theme you have chosen. 

 Under "Show Slides" you can choose whether you want to display all your slides or only some of 
them. 

 Under "Advance slides" I recommend that you select Manual, if you have a speaking engagement. 
If your presentation just needs to run in a loop, select Using timings, if present. Of course it 
requires that you have chosen that slide transitions and animations occur automatically in each 
slide. Otherwise the presentation will stop. 

There are also some advanced settings, where you can select the screen resolution and choose to use 
multiple monitors. When you give a lecture, you often connect a laptop to a projector. The advanced 
settings allow the projector to display the slide show while you can view slides with notes on the notebook. 
This is good, because then you have keywords at your fingertips without having to fiddle around with 
paper notes. 

3. Click OK, when you have chosen your settings. 
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5.5.1 Custom Slide shows 

Imagine that you are project manager on a major project in a company, and you have to report on the 
project status to the management, the safety group and the union representatives. Much of what is to be 
presented will be the same, but there might be some things that only the management should hear. The 
safety group is only interested in the schedule and the safety aspects, so there is also a difference between 
what this group and the union representatives need to hear.  

The usual way to solve this problem is to first make a slide show with all the information and save it as a 
"leadership presentation". 

Then you delete the slides that union representatives should not see and save the presentation in a new file 
as a union presentation. Finally, do the same thing with the presentation to the security group. 

But you can actually have all three presentations in the same file if you create custom slide shows. 

1. Click on the Custom Slide Show button. 
2. Click on the menu item Custom Slide Show , which appears. 

Figure 75: The Custom Slide Show button.

A window pops up with an (empty) list of your custom presentations. 

3. Click on the button New.

Another window opens. At the top you can give your custom presentation a name. You then mark the 
slides in the left pane that you want to import and click the Add >> button to transfer them to the right 
pane.

If you have done all the exercises in this book, your presentation will look like mine. Now let us create a 
customised presentation that shows only our title slide and the slide where we have inserted pictures and 
video clips. 

4. Set the custom slide show as shown in Figure 38 and name it “Multimedia”. 
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Figure 76: Settings for Custom Slide show.

You can also change the order in this presentation. You do this by clicking on a slide in the right pane and 
moving it up or down the list by using the two arrows to the right of the pane. 

5. When you are finished, click on OK.
6. Click on New again. 

In this slide show, we will also show the title slide, but in addition only the "technical" slides with graphs, 
charts and tables. 
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Name the presentation “Technical” and set the settings as shown. 

Figure 77: Setting another custom defined slide show.

7. Click OK.

You now have two slide shows on your list. This means you have three slide shows in total. You have 
your two custom shows, and you also still have the complete slide show. 

8. Click Close.

To view the complete slide show, choose the Slide Show Tab in the Ribbon and click the button From The 
Beginning. Alternatively you can just press the F5 key on your keyboard 

Figure 78: You have two slide shows.

To view one of the custom slide shows, you also choose the Slideshow Tab in the Ribbon and click the 
Custom Slideshow button. The corresponding menu item appears. Click it to get back inside the window, 
as shown in Figure 40 Then choose which show you want to view and click the View button. 
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